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APPENDIX 303a 

 
CAREER TECHNICAL SKILLS TRAINING (CTST) INSTRUCTIONS FOR 

COMPLETING FORM CTST-1, CTST-2 AND CTST-3 
 
 
A. Form CTST-1 CAREER TECHNICAL SKILLS TRAINING ANNUAL SUMMARY 

summarizes and requests approval for annual plan of CTST projects for a center. The 
form in its entirety, the Excel-based Form CTST-1 is comprised of six tabs:  

 
• Instructions  
• CTST Plan  
• TRADE SIG – Trade Signatures 
• ADMIN SIG – Administrative Signatures  
• OTHER SIG – Other Signatures  
• REVIEW – Office Of Job Corps Use Only  
 
(1) The four tabs highlighted in red are required to be completed by the center; the 

green tab is required to be completed by the Regional Office.  All questions 
should be answered completely.   Unless otherwise noted, all white fields should 
be completed, using prescribed formats where indicated.  Fields shaded in grey 
should not be manipulated. 

 
(2) The instructions describe the use of this Microsoft Excel-based document to 

record CTST projects; describe each tab included in the document; and define the 
information and data to be entered into each field of these tabs. 

 
(3) The CTST annual summary collects data and information for processing annual 

CTST plan, comprised of projects submitted using Form CTST-2. 

Each Form CTST-1 is required to include: 

(1) REGION:  the center's region from the pull-down menu. 
(2) CENTER:  the center name from the pull-down menu. 
(3) CONTRACT #: Enter the official contract number of the most recent DOL 

contract for the center operator.  Do not use internal reference numbers.  
Forest Service centers should enter "USDA." 

(4) Each of the following fields constitutes the record of a CTST project.  
Each CTST project record is captured in a single line of the table in this 
form, and all information can be found on each individual Form CTST-2. 

a. PROJECT ID:  Enter the six digit code from the Project ID field 
from the top of the Form CTST-2.   

b. TITLE:  Enter the text from the Title field at the top of each Form 
CTST-2. 
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c. CTST REQUEST:  Enter the amount from the CTST Request 
field at the bottom of the Form CTST-2.  

d. CENTER TRADE OFFERINGS AND SLOT COUNT: Enter 
the CTT trade and slot count in the designated fields. 

e. TOTAL COST REQUESTED:  Enter the amount from the Total 
CTST Cost field at the bottom of the Form CTST-2 

f. EST. VALUE:  Enter the amount from the Est. Value field at the 
bottom of the Form CTST-2. 

g. STATUS:  FOR Regional Office of Job Corps USE ONLY - 
Enter the current status of each CTST project before uploading 
Form CTST-1 to the Regional Share point folder. Do NOT erase or 
delete proposals that have been declined or withdrawn; follow 
instructions in PRH Appendix 303. 

 Do NOT enter information in the grey fields.  These fields are 
automatically calculated from the data entered in the table.  

(5) TRADE SIGNATURES: This tab provides a signature page to be signed 
and dated by center instructors and NTC representatives to indicate 
knowledge and approval of relative CTST projects included in the Form 
CTST-1.  Failure to do so may result in delay of CTST processing or 
decline of projects. 

a. SIGNATURE:  Center instructors and NTC representatives should 
sign here after reviewing the CTST projects that relate to their 
trade. 

b. PRINT NAME:  Signatories should neatly print their name here 
after signing. 

c. DATE:  Signatories should neatly print the date of signing here 
after signing. 

d. TITLE:  Signatories should neatly print corporate title here after 
signing. 

e. Each of the three corporate positions should provide the signatures 
on the Form CTST-1.  Failure to do so may result in delay of 
CTST processing or decline. 
 
This page should be printed and signatures collected; do not mark 
"Signature on file" or indicate similarly.  The complete signature 
page should be scanned and attached to the Form CTST-1 in the 
Attach tab.  

 
(6) ADMINISTRATION SIGNATURES: This tab provides a signatures page 

to be signed and dated by the Center Director, CTT Manager/CTST 
Coordinator, and Safety Coordinator to indicate knowledge and approval 
of all CTST projects included in the CTST plan. 
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a. SIGNATURE:  The administrative positions indicated should sign 
here after reviewing all of the CTST projects. 

 
b. PRINT NAME:  Signatories should neatly print their name here 

after signing. 
 
c. DATE:  Signatories should neatly print the date of signing here 

after signing. 
 
d. TITLE:  Signatories should neatly print corporate title here after 

signing. 
 

Each of the three corporate positions should provide the signatures 
on the Form CTST-1.  Failure to do so may result in delay of 
CTST processing or decline. 
 
This page should be printed and signatures collected; do not mark 
"Signature on file" or indicate similarly.   

 
(7) OTHER SIGNATURES: This tab provides a signatures page to be signed 

and dated by other necessary dignitaries to indicate knowledge and 
approval of all CTST projects reported on in this document and the 
truthfulness of the data contained herein. 

 
a. SIGNATURE:  The individual should sign here after reviewing 

all of the data and information reported and that it truthfully 
reflects the state of the CTST projects listed. 

 
b. PRINT NAME:  Signatories should neatly print or type their 

name here after signing. 
 
c. DATE:  Signatories should neatly print or type the date of signing 

here after signing. 
 
d. TITLE:  Signatories should neatly print or type their corporate 

title here after signing.  Each of the three corporate positions 
should provide the signatures on the CTST Bi-Annual Activity 
Report.  This page should be printed and signatures collected; do 
not mark "Signature on file" or indicate similarly.   

 
(8) REVIEW (FOR REGIONAL OFFICE OF JOB CORPS USE ONLY): 

This tab provides Regional Office staff with a center summary on 
approval status and the checklist for project and summary review. This tab 
includes the following repeating fields:   
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a. RECEIPT DATE @ REGION:  Enter the date the Form CTST-1 
was received at the Regional Office. 

 
b. REGIONAL COR:  The federal Contracting Officer's 

Representative (COR) responsible for reviewing and submitting 
the center's plan to the National Office for review should type 
his/her name in this field. 

 
c. RECEIPT DATE @ NATIONAL:  National Office staff will 

enter the date the Form CTST-1 was received at the National 
Office. 

 
d. REPORT REVIEW/REGION RESPONSE:  Regional Office 

staff should choose a "YES" or "NO" response from the drop-
down menu to answer each question.  Responses that appear in red 
should be rectified before sending the center's CTST materials to 
the National Office for review. 

 
The center's COR and the Regional Director should sign a printed 
copy of the completed page and the signature page should be 
scanned and attached to the Form CTST-1 in the Attach tab as 
instructed. 

 

B. Form CTST-2 CAREER TECHNICAL SKILLS TRAINING PROJECTION 
DESCRIPTION summarizes and request approval for annual plan of CTST projects for a 
center. The form in its entirety is comprised of 12 tabs: 

 
• INSTRUCTIONS 
• FORM - CTST PROJECT DESCRIPTION 
• EST 1 - MATERIALS AND SUPPLIES ESTIMATE 
• EST 2 - JOB-SITE POWER TOOLS AND EQUIPMENT ESTIMATE 
• EST 3 - EQUIPMENT RENTAL ESTIMATE 
• EST 4 - CONTRACTED SERVICES ESTIMATE 
• EST 5 - AGENCY TECHNICAL SERVICES ESTIMATE 
• EST 6 - MOTOR VEHICLE OPERATIONS/MAINTENANCE ESTIMATE 
• SHA - SAFETY HAZARD ANALYSIS 
• ATTACH – ATTACHMENTS 
• HAZARDS - HAZARD CATEGORY DESCRIPTIONS 
• REVIEW - OFFICE OF JOB CORPS USE ONLY 

 
(1) The nine tabs highlighted in red are required documents, to be completed by 

the center.  All questions should be answered completely.   Unless otherwise 
noted, all white fields should be completed, using prescribed formats where 
indicated.  Fields filled in grey should not be manipulated.   
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(2) Instructions describe the use of this Microsoft Excel-based document to record 
CTST projects; describe each tab included in the document; and define the 
information and data to be entered into each field of these tabs. 

 
(3) FORM - CTST PROJECT DESCRIPTION is the principal record and used to 

develop, document, and request approval for an individual CTST project. It 
provides the detail for an individual project and key information is transcribed 
from it to the Form CTST-1 and Form CTST-3.  This tab includes the 
following fields:  

  
(1) REGION:  Select the center's region from the pull-down menu. 
(2) CENTER:  Select the center name from the pull-down menu. 
(3) START DATE:  Provide the projected start date of the project. 
(4) OUTCOME AND TRAINING DESCRIPTION: Please see Appendix 

303b for sample description. 
 
a. PROJECT ID:  Enter a unique project number using a two-

letter center abbreviation (e.g. "HF" for Harpers Ferry); the last 
two digits of the program year being applied for (e.g. "13"); 
and a sequential and unique reference number (e.g. "01" or 
"10").  Example, HF-13-01. 
 

b. TITLE:  Enter a brief and descriptive title for the project.  For 
instance, "New Lights Female Dorm (Bldg. 12) Bathrooms.” 

 
c. EST. DAYS TO COMPLETE:  Enter the total number of 

working days necessary to complete the project.  For instance, 
if the project is expected to take four weeks to complete 
without holiday interruption and a Monday through Friday 
schedule, the Est. Days to Complete would be 20 days.  
Manually enter the estimated date of completion to the right. 

 
d. TRADE / # SLOTS / WORK DAYS:  There are three fields 

to complete in this section, which are repeated across the form 
three times; offering 12 field sets for information.  In the Trade 
field select an approved CTST-eligible trade from the pull 
down menu; immediately to the right, in the # Slots field, enter 
the number of approved training slots; and, immediately to the 
right of that field, in the Work Days field, enter the number of 
work days that trade is expected to be active on the work site.  
If entering another trade, move to the line below and perform 
the same entry sequence.  If a Carpentry program has 24 
approved slots and will be actively working on a project for 
half of the 4 full weeks a project will last, the entry should be 
Carpentry | 24 | 10 (4 full weeks = 20 complete days, and half 
of which is 10 work days. 
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e. BUDGET:  The Budget section is comprised of three columns 

- Category, CTST Funds Request, and Total.  The text 
appearing in blue in each CATEGORY line is hyperlinked to 
its corresponding estimate (EST) tab.  For instance, clicking on 
the text Materials and Supplies (Est. 1) will open tab Est. 1, 
where the user should enter detailed estimate expense data for 
this category.  

Do NOT enter amounts in the grey fields; these will be 
populated automatically using information provided in the 
estimate tabs (see instructions below) and the resulting inputs. 

f. OUTCOME DESCRIPTION:  Provide a brief and concise 
narrative describing: 1) the deficiency identified to justify the 
project and 2) the final product as a whole and its design 
characteristics and phases of construction.  If applicable, 
identify multi-year project status here and accommodation 
plans devised to provide for normal center operations during 
construction.  
 

g. TRAINING DESCRIPTION:  Provide a brief and concise 
narrative that describes how students will fulfill each phase of 
construction as described in the Outcome Description field.  
 

(5) EST 1 (MATERIALS AND SUPPLIES ESTIMATE) This tab assists in 
developing the CTST project budget and provides reviewers with detailed 
cost estimate information.  Each line's # of Units and Unit Cost field 
automatically calculates the Line Cost field, and the sum of these fields is 
automatically calculated into Sum Total.  The Sum Total amount 
automatically populates the Materials and Supplies (Est. 1) field in the 
CTST Funds Request column on the Form tab. This tab includes the 
following fields:   

 

a. MATERIAL OR SUPPLY DESCRIPTION (QTY. PER 
UNIT) - Enter a description of the material or supply needed 
and, if sold packaged in a quantity, the quantity per package.  
For instance, "Barrel of 10 penny nails (10,000/barrel).” Note: 
NOTE: This list is an estimate only; instructors have the ability 
to ensure that the correct materials supplies and tools are 
ordered on the purchase requisitions based on the actual project 
requirements at the time of actual project starting. Center must 
allow for this flexibility in the ordering process due to timing, 
changes, weather, safety issues, & local and state building 
codes, etc.  
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b. # OF UNITS - Enter the quantity of single materials or 
supplies entered in the field to the left or, if sold in packaged 
quantities, the number of packages needed.  For instance, if the 
project requires 100,000 10 penny nails and each barrel of nails 
includes 10,000, 10 barrels are required for the project and 
"10" would be entered in this field. 

 
c. UNIT COST - Enter the cost of single materials or supplies 

entered in the far-left field or, if sold in packaged quantities, 
the cost per package.  For instance, if each barrel of nails sells 
for $12.66, enter "12.66."  The number entered will 
automatically format into dollars. 
 

d. LINE COST - Do NOT enter data into the field.  This field 
automatically calculates by multiplying the # of Units by the 
Unit Cost. 

 
(6) EST 2 (JOB-SITE POWER TOOLS AND EQUIPMENT ESTIMATE): 

This tab assists the center in developing its budget for the CTST project and 
provides reviewers with detailed cost estimate information.  Each line's 
Quantity and Unit Cost field automatically calculates the Line Cost field, 
and the sum of these fields is automatically calculated into Sum Total.  The 
Sum Total amount automatically populates the Job-Site Power Tools and 
Equipment (Est. 2) field in the CTST Funds Request column on the Form 
tab.  This tab includes the following fields:   

 
a. JOB-SITE POWER TOOLS OR EQUIPMENT 

DESCRIPTION - Enter a description of the power tool or 
equipment necessary for completion of this CTST project.  For 
instance, "Cordless 18v drill." 
 

b. QUANTITY - Enter the quantity of single power tool or 
equipment entered in the field to the left.  For instance, if the 
project requires 2 cordless drills, enter "2" in this field. 
 

c. UNIT COST - Enter the cost of single tool or equipment 
entered in the far-left field.  For instance, if each cordless drill 
sells for $56.75, enter "56.75."  The number entered will 
automatically format into dollars. 
 

d. LINE COST - Do NOT enter data into the field.  This field 
automatically calculates by multiplying the Quantity by the 
Unit Cost.  

 
(7) EST 3 (EQUIPMENT RENTAL ESTIMATE): This tab assists in 

developing the CTST project budget and provides reviewers with detailed 
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cost estimate information.  Each line's Quantity and Unit Cost field 
automatically calculates the Line Cost field, and the sum of these fields is 
automatically calculated into Sum Total.  The Sum Total amount 
automatically populates the Equipment Rental Estimate (Est. 3) field in the 
CTST Funds Request column on the Form tab.  This tab includes the 
following fields:   

 
a. EQUIPMENT DESCRIPTION (RENTAL UNIT) - Enter a 

description of the equipment to be rented and, in parenthesis, 
the rental unit.  For instance, "150 psig air compressor trailer 
(day)." 

b. QUANTITY - Enter the estimated quantity of rental units for 
the equipment entered in the field to the left.  For instance, if 
the project requires the compressor for 15 days, enter "15" in 
this field. 

c. UNIT COST - Enter the cost per rental unit for the equipment 
entered in the far-left field.  For instance, if the compressor 
rents for $25.00 per day, enter "25."  The number entered will 
automatically format into dollars. 
 

d. LINE COST - Do NOT enter data into the field.  This field 
automatically calculates by multiplying the Quantity by the 
Unit Cost.  

 
(8) EST 4 (CONTRACTED SERVICES ESTIMATE): This tab assists in 

developing the CTST project budget and provides reviewers with detailed 
cost estimate information.  Each line's Quantity and Unit Cost field 
automatically calculates the Line Cost field, and the sum of these fields is 
automatically calculated into Sum Total.  The Sum Total amount 
automatically populates the Contracted Services Estimate (Est. 5) field in 
the CTST Funds Request column on the Form tab. This tab includes the 
following fields:   

 
a. CONTRACTOR/SERVICE DESCRIPTION - Enter the 

name of the contractor (if known) and a detailed description of 
the service to be performed.  For instance, "PNW Services - 
concrete cylinder compressive strength test." 
 

b. QUANTITY - Enter the estimated quantity of the services 
entered in the field to the left.  For instance, if the project 
requires one test, enter "1" in this field. 

 
c. UNIT COST - Enter the cost per unit for the services entered 

in the far-left field.  For instance, if each test costs $300.00, 
enter "300".  The number entered will automatically format 
into dollars. 
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d. LINE COST - Do NOT enter data into the field.  This field 

automatically calculates by multiplying the Quantity by the 
Unit Cost.  
 

(9) EST 5 (AGENCY TECHNICAL SERVICES ESTIMATE): This tab is to be 
completed by USDA Forest Service-managed centers only.  This tab assists 
in developing the CTST project budget and provides reviewers with detailed 
cost estimate information.  Each line's Quantity and Unit Cost field 
automatically calculates the Line Cost field, and the sum of these fields is 
automatically calculated into Sum Total.  The Sum Total amount 
automatically populates the Agency Technical Services Estimate (Est. 6) 
field in the CTST Funds Request column on the Form tab. This tab includes 
the following fields:   

 
a. CONTRACTOR/SERVICE DESCRIPTION - Enter the 

name of the contractor and a detailed description of the service 
to be performed.  For instance, "USDA Forest Service - 
Facilities - LEED audit." 

b. QUANTITY - Enter the estimated quantity of the service 
entered in the field to the left.  For instance, if the project 
requires one audit, enter "1" in this field. 

c. UNIT COST - Enter the cost per unit of service entered in the 
far-left field.  For instance, if each audit costs $5,000.00, enter 
"5000".  The number entered will automatically format into 
dollars. 

d. LINE COST - Do NOT enter data into the field.  This field 
automatically calculates by multiplying the Quantity by the 
Unit Cost. 

  
(10) EST 6 (MOTOR VEHICLE OPERATIONS/MAINTENANCE 

ESTIMATE): This tab assists in developing the CTST project budget and 
provides reviewers with detailed cost estimate information.  Each line's 
Quantity and Unit Cost field automatically calculates the Line Cost field, 
and the sum of these fields is automatically calculated into Sum Total.  The 
Sum Total amount automatically populates the Motor Vehicle 
Operations/Maintenance (Est. 7) field in the CTST Funds Request column 
on the Form tab.  This tab includes the following fields:   

 
a. OPERATION/PART/REPAIR DESCRIPTION - Enter a 

detailed description of what operation of the motor vehicles 
will be performed, or what parts or repair services it may need 
to undergo during the project.  For instance, "Daily roundtrip to 
work site - 40 miles" or "Oil change.” 
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b. QUANTITY - Enter the estimated quantity of the operation, 
part, or repair entered in the field to the left.  For instance, if 
the project requires 15 roundtrip commutes to the work site, 
enter "15" in this field. 

 
c. UNIT COST - Enter the cost per unit for the equipment 

entered in the far-left field.  For instance, if each trip is 
estimated to cost $22.00 in gas and $10.00 in tolls, enter "32."  
The number entered will automatically format into dollars. 
 

d. LINE COST - Do NOT enter data into the field.  This field 
automatically calculates by multiplying the Quantity by the 
Unit Cost.  

 
(11) SHA (SAFETY HAZARD ANALYSIS): This tab assists in limiting 

student exposure to injury and fatality during the CTST project and 
provides reviewers with detailed risk assessment information.  The table 
simplifies the process by utilizing hazard categorization and hazard 
control and abatement strategy modeled on OSHA-developed standards. 
Each line in this tab comprises a single record and includes the following 
fields:   
 

a. ACTION/HAZARD DESCRIPTION - Enter a detailed 
description of tasks identified with potential hazards and the 
hazard linked to the task.  For instance, in a construction 
project requiring metal grinding in relatively close quarters, a 
task and hazard description could be described as "Worker 
grinding metal in close quarters of other workers - risk of 
sparks and projectiles from fragmenting metal and/or breaking 
grinding discs." 
 

b. HAZARD CATEGORY - Select from the pull-down menu a 
category of precaution to mitigate the hazard that is identified.  
For instance, one category of the above example is "Struck by 
(Mass acceleration)"; identifying the possibility of flying metal 
debris hitting a co-worker.   If assistance is needed in matching 
a hazard from the description field to a hazard category, click 
on the Hazard Category text at the top of the column; it is a 
hyperlink to a separate tab which has OSHA definitions of the 
hazard categories. 

 
c. PROPOSED CONTROL/ABATEMENT - Select from the 

pull-down menu a category of control or abatement for the 
identified hazard.  For instance, one category of the above 
example is "Engineering control - fully enclose the hazard to 
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limit access/exposure"; identifying the use of an enclosed 
shield to limit the distance flying metal debris could travel.   
An entry in the Action/Hazard Description field may present 
several possible Hazard Category possibilities; each may be 
addressed using the same or different Proposed Control/ 
Abatement categories.  For instance, the Action/Hazard 
Description used above may also produce the Hazard Category 
entry "Mechanical/Vibration (Chaffing/Fatigue),” identifying 
the possibility that the grinding disc may break and disperse.  
Furthermore, the Proposed Control/Abatement may be the 
same as the original record, or may involve other solutions.  In 
this case, a solution to replace the grinding discs with a more 
stable product would result in a Proposed Control/Abatement 
of "Engineering control - Substitute cause of hazard with other 
material/process" or the use of protective gear would result in a 
Proposed Control/Abatement of "PPE - Protective body 
clothing/footwear" and "PPE - Safety eye ware".  In such cases, 
the Action/Hazard Description should be repeated and the 
subsequent and unique Hazard Category and a Proposed 
Control/Abatement identified to specifically address the new 
record.   

 
(12) ATTACH (ATTACHMENTS): This tab provides a place to attach 

electronic documents that are specifically related to the CTST project; keeps 
all related information and materials in one electronic file, and keeps 
documents from getting lost or misplaced.  Missing documents may cause 
processing or approval delay. 

 
Attached documents may include those created by any Microsoft program 
and Adobe PDF files; common visual and movie file types, such as JPEG 
and WMV; professionally-produced technical and A/E drawings; and 
HTML-formatted files.  Files with the following file extensions are 
accepted: .avi, .bmp, .csv, .doc, .docx, .dwf, .dwg, .gif, .htm, .html, .jpg, 
.jpeg, .mpg, .mpp, .mp4, .pdf, .png, .pub, .rtf, .tif, .tiff, .txt, .wmf, .wmv, .xls, 
.xlsx, and .xps. 

The attachment process is made possible using Microsoft Excel's 
Insert/Object feature.  To use this feature in Excel 2007, follow these steps: 

 
1. Click in an empty Excel field in the Attachment column. 
 
2. On the Insert tab at the top of the program window, click on 

Object. 
 
3. On the Object window, click on the Create From File tab. 
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4. In the Create From File tab, make sure the Display As Icon 
check box is checked and use the Browse button to locate a 
document you want to attach; double-click on the file you want 
to attach, and click on the OK button. 

 
5. Include a description of the document in the Description field 

to the right of your attachment. 

(13) Separate cost estimates for materials and supplies, job-site power tools, 
equipment rental, contracted services, agency technical services (USDA 
centers only), and motor vehicle operations and maintenance. 
 

(14) A Safety Hazard Analysis identifying project tasks and risks to participants 
and by-standers; categorization of each identified risk; and categorization of 
tactics that will be used to abate identified risks in each task. 

 
 

(15) For projects proposing renovation or new construction of a structure or 
building, attachments within the Form CTST-2 should provide: 

a. Single line technical drawings illustrating and/or describing the 
project outcome’s location and situation; basic dimensions and 
construction features; adherence to federal standards and local 
code; if applicable, details of any major systems changes as 
identified above in item 4f; building and construction types 
utilized; and approximate square footage. 

b. List and schedule of required licenses, authorizations, and/or 
permits. 

c. Plan to accommodate current building functions while 
construction/rehabilitation is underway. 

d. Form CTST-2 may also, but are not required to, include 
supporting images that are numbered and include a caption or 
legend; technical specification documentation of equipment to 
be installed; letters of community support; and other such 
consequential records. 

 
(16) Individual projects involving less than $2,500 in direct project costs shall be 

combined under one project number and titled “Miscellaneous Construction 
Projects,” and described on a single Form CTST-2. The following best 
practice is recommended: Submit one miscellaneous CTST-2 for all trades 
combined or submit one miscellaneous CTST-2 for each CTST trade 
offered. 
 

(17) Modification to a previously submitted Form CTST-2 are identified as:  
a. Administrative modifications are identified as those 

encompassing the provision of absent but required signatures 
or documentation or the correction of minor calculation errors. 
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Centers will resubmit an updated and complete Forms CTST-1 
and CTST-2 to the center’s Regional Share Point website. 

b. Major modifications are identified as those encompassing 
change in scope, project location or building identification, 
trade participation, fund request amount, or similarly 
significant project elements. Centers will: 

c. Withdraw the project via written request to the Regional Office 
of Job Corps identifying the project by project ID number and 
title. 

d. Submission of a complete replacement project (if applicable) 
identified using a new and unique project identification 
number, and accompanied by an updated and complete Forms 
CTST-1 and CTST-2 including updated signatures. 

 
(18) Modifications to previously approved plans must be submitted and approved 

by the Regional and National Offices within the schedule provided below, 
prior to implementation, using the procedure documented above in item D. 
(1&2). 

                           

A. CTST-3 - CTST BI-ANNUAL ACTIVITY REPORT summarizes and report annual 
progress of Career Technical Skills Training (CTST) projects for a center. The Excel-
based Form CTST-3 is comprised of six tabs: 

 
• INSTRUCTIONS  
• FORM – CTST BI-ANNUAL ACTIVITY REPORT  
• ADMIN SIG – ADMINISTRATIVE  SIGNATURES 
• OTHER SIG – OTHER SIGNATURES  
• ATTACH – ATTACHMENTS 
• REVIEW – OFFICE  OF JOB CORPS USE ONLY 

 
(1)    The four tabs highlighted in red are required documents for centers. The 

Regional Offices must complete the tab highlighted in green. Each center is 
required to submit a Form CTST-3 for the six month period ending 
December 31 and the one-year period ending June 30th to its Regional 
Office within 30 days of those dates. All questions should be answered 
completely. Unless otherwise noted, all white fields should be completed, 
using prescribed formats where indicated. Fields filled in grey should not be 
manipulated.  

 
(2) INSTRUCTIONS - To describe the use of this Microsoft Excel-based 

document to report CTST project activity, describe each tab included in the 
document, and define the information and data to be entered into each field 
of these tabs. 
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(3) CTST BI-ANNUAL (twice a year) ACTIVITY REPORT – Submitted for 
the following timeframes. July 1 through December 31 activity by COB 
January 31. January1 through June 30 activity by COB August 31. This 
report is the principal record that is used to report CTST project status on a 
six month and annual basis as a summary. It provides detail for each project; 
center estimation on its completion cost and timeliness; and notes on 
circumstances regarding outstanding or uncompleted projects. If a project is 
not completed in the original CTST program year, center must include status 
of that project in the next CTST-3 submittal until it shows ups as 100% 
complete. This tab includes the following fields: 

 
(1) REGION: Select the center's region from the pull-down menu. 
(2) CENTER: Select the center name from the pull-down menu. 
(3) CONTRACT #: Enter the official identification number of the most 

recent DOL contract for operation of the center in this field. Do not 
use internal reference numbers. Forest Service centers should enter 
"USDA". 

(4) SUBMISSION DATE: Enter the date the Form CTST-3 is 
submitted to the Regional Office. 

(5) ACTIVITY SUMMARY FROM PERIOD: From the pull-down 
menu, select the time frame of activity this report presents.  

 
The fields below, starting with Project ID through Balance provided on a 
single line constitutes an individual project record: 

 
a. PROJECT ID: Copy each Project ID from the program year's 

Form CTST-1 and identify any other outstanding CTST 
projects still active. 

b. PERCENT COMPLETE: Enter the estimated percentage of 
construction work days completed to-date for the specific 
project. For instance, a project that has not yet begun would be 
listed as zero and one that was completed would be 100%. A 
project estimated to last 120 days that has completed 80 work 
days, would be listed as 67%; while the same project going 20 
days overestimate (140 days) would be listed as 117%. 

c. ACTUAL START DATE: Enter the date work on this 
specific project, as described in the Form CTST-2, actually 
started. 

d. EST. COMPLETE DATE: Enter the date the center 
anticipates completion of this specific project. If the project is 
complete, enter the actual date CTST activity on this specific 
project was completed. 

e. EST. WORKDAYS: (Do NOT enter data in this field) The 
field will automatically calculate estimated number of 
workdays to complete this specific project, based on the Actual 
Start and Est. Complete Dates, for reference only. 
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f. # OF TRADE SLOTS ACTIVE TO-DATE: Enter the 
number of trade slots that have actively participated in 
construction on the project as of the Submission Date of this 
report. Calculate this by identifying the trades active in 
construction, and adding their collective approved slot totals. 
For instance, if the carpentry trade with 24 slots, the plumbing 
trade with 12, and the facility maintenance with 20 slots plan to 
participate in a project, but only the first two trades have been 
active in the project to-date, enter the number "36." 

g. CTST AMOUNT FUNDED: Provide the total sum of CTST 
funds allocated for this specific project by the Regional Office. 

h. AMOUNT PAID OUT TO-DATE - CTST FUNDS: Provide 
the total of CTST funds the center has received for this specific 
project as of the report's Submission Date. 

i. EXPECTED TO COMPLETE ON-TIME & ON-
BUDGET?: If the outcome described in the specific project's 
Form CTST-2 will cost more than the amount recorded in 
form's CTST Request Amount field at the bottom of the CTST-
2; or if the actual completion date will fall more than 10 
working days beyond the Estimated Completion Date provided 
at the top of its Form CTST-2; or the actual completion date 
will occur after the end (June 30) of the program year indicated 
at the top of the project's Form CTST-1, choose False from the 
drop-down menu. If none of these statements apply choose 
"TRUE" from the drop-down menu. If "FALSE" is selected, 
provide an explanation as to why in the Notes field below. 

Choose "COMPLETE" if the project has been completed, and 
provide photographic record of the Form CTST-2's stated 
outcome's completion in the Attach tab as instructed below. 
Choose 

"WITHDRAWN" if the project has been formerly withdrawn 
from consideration/ fulfillment and all CTST-funded 
performance on the project has ceased. If any work was 
completed on the project, provide photographic record of its 
completion attached in the Attach tab as instructed below. 
Photos should be collated into a single file, preferably PDF, for 
each project in both of the above cases. 

BALANCE: (Do NOT enter data in this field) This field will 
automatically calculate the estimated balance of CTST funds 
due. 

j. NOTES: In this field, identify each project and provide 
explanation explaining expected completion or cost over-
runs for each project to which a "FALSE" response was 
provided in the Expected To Complete On-Time & On-
Budget? column. Providing explanation should not be 
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considered a request for multi-program year project status or 
additional funding; any such requests should be made in 
writing to the Regional Office per Appendix 303 of the 
PRH. 

 
(6)    ADMIN SIG (ADMINISTRATIVE SIGNATURES) This tab provides a 

signatures page to be signed and dated by the Center Director, CTT 
Manager/CTST Coordinator, and Safety Coordinator to indicate knowledge 
and approval of all CTST projects reported on in this document and the 
truthfulness of the data contained herein. This tab includes the following 
repeating fields: 

 
a. SIGNATURE: The administrative positions indicated should 

sign here after reviewing all of the data and information 
reported and that it truthfully reflects the state of the CTST 
projects listed. 

b. PRINT NAME: Signatories should neatly print or type their 
name here after signing. 

c. DATE: Signatories should neatly print or type the date of 
signing here after signing.  

d. TITLE: Signatories should neatly print or type their 
corporate title here after signing. 

Each of the three corporate positions should provide the 
signatures on the CTST Bi-Annual Activity Report. This 
page should be printed and signatures collected; do not mark 
"Signature on file" or indicate similarly. The complete 
signature page should then be scanned and attached to the 
Form CTST-3 in the Attach tab as instructed below. 

(7) OTHER SIG (OTHER SIGNATURES): This tab provides a signatures page 
to be signed and dated by other necessary dignitaries to indicate knowledge 
and approval of all CTST projects reported on in this document and the 
truthfulness of the data contained herein. This tab includes the following 
repeating fields: 
 

a. SIGNATURE: The individual should sign here after 
reviewing all of the data and information reported and that it 
truthfully reflects the state of the CTST projects listed.  

b. PRINT NAME: Signatories should neatly print or type their 
name here after signing. 

c. DATE: Signatories should neatly print or type the date of 
signing here after signing 

d. TITLE: Signatories should neatly print or type their 
corporate title here after signing. 

Each of the three corporate positions should provide the 
signatures on the CTST Bi-Annual Activity Report. This 
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page should be printed and signatures collected; do not mark 
"Signature on file" or indicate similarly. The complete 
signature page should then be scanned and attached to the 
Form CTST-3 in the Attach tab as instructed. 

(8) ATTACH (ATTACHMENTS) This tab provides a place to attach 
electronic documents that are specifically related to the CTST project; 
keeps all related information and materials in one electronic file, and 
keeps documents from getting lost or misplaced. Missing documents may 
cause processing or approval delay. 

Attached documents may include those created by any Microsoft program 
and Adobe PDF files; common visual and movie file types, such as JPEG 
and WMV; professionally-produced technical and A/E drawings; and 
HTML-formatted files. Files with the following file extensions are 
accepted: .avi, .bmp, .csv, .doc, .docx, .dwf, .dwg, .gif, .htm, .html, .jpg, 
.jpeg, .mpg, .mpp, .mp4, .pdf, .png, .pub, .rtf, .tif, .tiff, .txt, .wmf, .wmv, 
.xls, .xlsx, and .xps. 

The attachment process is made possible using Microsoft Excel's 
Insert/Object feature.  

To use this feature in Excel 2007, follow these steps: 

1.  Click in an empty Excel field in the Attachment column. 

2.  On the Insert tab at the top of the program window, click on 
Object. 

3.  On the Object window, click on the Create From File tab. 

4.   In the Create From File tab, make sure the Display As Icon 
check box is checked and use the Browse button to locate a 
document you want to attach; double-click on the file you want 
to attach, and click on the OK button. 

Include a description of the document in the Description field to the 
right of your attachment. 

(9)       REVIEW (For Regional Office of Job Corps Use Only): This tab provides 
Regional Office staff with a center summary on approval status and the 
checklist for project and summary review. This tab includes the following 
repeating fields: 

a.      RECEIPT DATE @ REGION: Enter the date the Form 
CTST-3 was received at the Regional Office. Reports are due 
to the National Office 30 days after the submission deadline. 

b.      REGION COR: Enter the name of Regional Office 
Contracting Officer’s Representative (COR) responsible for 
reviewing and submitting this report to the National Office. 
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c.      RECEIPT DATE @ NATIONAL: National Office staff 
will enter the date the Form CTST-3 was received at the 
National Office. 

d.      REPORT REVIEW/REGION RESPONSE: Regional 
Office staff should choose a "YES" or "NO" response from 
the drop-down menu to answer each question. Responses that 
appear in red should be rectified before sending this report to 
the National Office or explanation provided in the Notes 
field. 

The center's Regional Office COR assigned to the center on 
the Submission Date of this report, or designated 
representative, and the Regional Director should sign a 
printed copy of the completed page, and the signature page 
scanned and attached to the Form CTST-3 in the Attach tab 
as instructed above. 

 


